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1. Introduction

bcAdmin will make working with batcorder recordings as well as other bat call files a lot 
easier. It takes away most of the organizing and supports you when analyzing. It is fine 
tuned to work with the batcorder and presents an elementary part of the batcorder-system. 
It is the database that stores information and does intelligent analysis.

The applications is primarily focused on the management of recordings and their meta in-
formation as well as the output of data compilations based on the raw data. In addition it 
automatically searches your recordings for bat calls, and takes measures of all found calls 
so batIdent can identify bat species. The meta information belonging to recordings are 
stored in a database-like file and can be filtered and otherwise manipulated.

bcAdmin was growing tied to the batcorder from its first release more than 10 years ago. It 
had to be able to cope with ever new arising tasks. bcAdmin4 is definitely the most power-
ful version we released and contains many new functions that were shaped from your in-
put.

2. Installation
System requirements for running bcAdmin4 are an Apple Mac with Intel-CPU running Mac 
OS 10.15 or newer. We do recommend macOS 12 or newer and it may become mandat-
ory in future.

We recommend at least 4GB of memory. After downloading the application zip archive, ex-
tract it into your Applications folder. If you are already using an older version of bcAdmin, 
we recommend you first rename the old version. To use the automatic identification you‘ll 
need batIdent and its components.

bcAdmin4 features an update process and will inform you if updates are available on our 
server. It can download the updates. To install the updates you have to quit bcAdmin 4 and 
copy the downloaded file to the applications folder (or where your bcAdmin copy resists). 
You can overwrite the existing version, the data is stored apart from the application file.
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3. Overview of bcAdmin4
3.1. What does bcAdmin?

bcAdmin is designed to manage and analyse your bat call recordings. It combines a data-
base with a sound analysis tool and creates tables and graphs for your reports. It works 
together well with batIdent and thus can obtain automatic species identification through it. 
That way you quickly get per species activity patterns and reports. In short: no need to 
switch between sound analysis app and spreadsheet app - it‘s all within bcAdmin.

Since many steps in the analysis process are automated within bcAdmin, working with 
large datasets as created by passive recording systems is at least possible in a meaningful 
way. Only due to the objective call measurement and identification a basis for comparison 
of locations and nights is possible. Wether you‘re doing acoustic monitoring, comparison of 
activity for consulting or diversity indices - bcAdmin is the optimal tool for your work.

While the app is optimized for batcorder recordings, it works well with files of other sys-
tems as well. Nevertheless, many devices produce recordings with echoes or otherwise 
low sound quality. For these taking of automatic measurements may give less viable res-
ults or none at all. Note that some features of bcAdmin require special form of data only 
produced by the batcorder. Thus, some features may not work or only work partially with 
other recordings.

3.2. Short functional overview

Recordings are connected in bcAdmin to meta information regarding the sampling efforts  
(sessions) and location. Sessions and recordings may be filtered or grouped based on this 
data. Analysis of calls is done using an unique and lightning-fast algorithm. It works in 
batch-mode, finds every call matching your settings and takes measurements for each 
call. All calls can also been displayed on a per file basis and you can manually correct calls 
misclassified by batIdent (working for European bat species only). Per recording a maxim-
um of three species entries is possible.

The comparison of data is possible due to the objective approach of call and species iden-
tification. Using these results calculations of activity based on recording count, recording 
duration or other activity groupings can be done. Different functions also visualise your 
data. Complex graphs can easily be created by a few clicks. In addition you can export 
data, graphs and do further calculations in any other application you like.
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3.3. Data structures

Before working with bcAdmin it is important to understand its concept of data manage-
ment. The basic unit in bcAdmin is the Session. It includes the recordings of one device 
and one night. This data container is used throughout the program for calculations of 
activity and all data should be organized that way. You can group sessions in Projects for 
getting a better overview. Within a Session recordings are collected. To keep the database 
performant, the recordings themselves are not stored in the database, only meta-informa-
tion and a link to the file is included. The recording files are kept outside the database 
on your hard disc. The same accounts for the measurement files (.bcCalls, .csv and .res 
after batIdent was run), these are stored also on disc, parallel to the recording files in the 
same folder. 

So after importing recordings into bcAdmin, you should not delete the files. Each 
session keeps a link to the path of the recordings. This file location can be changed if 
files are moved for example from internal to an external disk. We chose this system, since 
then you can easily backup files and other applications like bcAnalyze can easily access 
the recordings and related files. 
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After importing and analysing the recordings you could delete the recording files to save 
disk space. While that is tempting, we recommend to not delete these files, but maybe first 
back them up. bcAdmin offers to archive the files of If later new tools allow better analysis 
you can re-analyze your data. In addition to Sessions and Recordings other objects like 
Locations and Projects are stored within the bcAdmin database. Sessions can be connec-
ted to these objects and thus be grouped.

To import results bcAdmin holds a list of all species results of batIdent. A complete over-
view is given in the Taxon-Editor of bcAdmin. There you can also change display colors for 
selected species.

Apart from recording relevant entries (session, recording) additional objects can be cre-
ated and stored. These are projects, taxa, location and environmental data (including for 
example wind measures and temperatures).
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4. Creating database entries
As mentioned above, information is organised in Session, Project and Location objects 
within bcAdmin. When importing recordings and thus creating a new session, the addition 
of a project or location is not necessary. It can be done later on as well. Nevertheless, to 
utilise some functions, locations are necessary. We thus recommend to not be too lazy, but 
keep your database up to date. Sessions can be connected to locations and projects any 
time. The following chapters will shed some more light on the data structures and show 
how to import data easily.

4.1. Locations

If the batcorder is used for a single or multiple nights for passive, stationary monitoring in-
formation for this location can be stored within bcAdmin.  Note that bcAdmin is primarily 
designed for working with data from one location per night, and thus not optimized for 
transect data. Yet as explained in a later chapter, it can be used for mobile sampled data 
as well.

Usually a location is connected to a session. To create new locations or modify existing 
ones choose Window -> Locations and a window opens. There you get a list of all avail-
able locations. In addition you can filter locations and edit selected locations. For referen-
cing a location throughout bcAdmin it needs a name and entry for closest city. You can 
copy and paste locations using the standard shortcut cmd+c and cmd+v.

Coordinates
Coordinates can be added in decimal degrees (WGS84). Using these coordinates bcAd-
min can calculate for example sunset and sunrise times. They can also be acquired from 
the map. Choose „Set coordinates from map“ and then mark the location by right clicking 
within the map. Next save the coordinates and proceed as usual.

Show sun times
This function gives a graph showing sunset and sunrise times. It may be useful in planning 
batcorder timer setup in advance. It needs coordinates to be set for the location.
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Central store
bcAdmin 4 has a new feature. It creates a central database per Mac user and uses in-
formation on location and taxa stored there as default when creating new databases. To 
add locations to the central store you can select one or multiple in the location editor and 
copy them to the central store. You also can import from the central store. To view the 
central store choose from Window menu the command Shared locations.

4.2. Projects

Projects offer the possibility to organise your sessions similar to your work projects. Pro-
jects are shown and maintained in the leftmost column of the document window. Per right-
click or with the +-button (window bottom) projects and groups can be created. 

Next to each project a number indicates the number of sessions contained within the pro-
ject. After you have selected a project, the session table will reload and only sessions be-
longing to the project will get displayed. You can add folders for organising your projects. 
Sessions can be assigned only to projects and not to folders.

Projects can create subgroups either dynamically or manually. These subgroups are a list 
of all locations and flag states of sessions within this project. The default setting is that you 
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have to manually initiate the subgroup creation via the context-menu of a project. You can 
also set bcAdmin to automatically create these groups whenever the project groups is 
opened. The subgroups will be used best for projects with either many locations or many 
different flag states.

4.3. Taxon-Editor

The Taxon-Editor gives an overview of all species integrated into bcAdmin and their tree 
like organization. It is taken directly from batIdent and resembles the id process. For each 
taxon entry colors as well as the group can be chosen freely. 

Taxa are stored per database and can be independently edited for each database. The 
taxa list can be imported from a .plist file or exported to a .plist file. The central taxon editor 
can be accessed from Window menu using Shared taxa.
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5. Typical workflow 
5.1. Workflow overview

The following scheme displays the typical steps when working with bcAdmin:

❖ A: Creation of Session and recordings. This can be done manually or, as recommended, 
automatically via the batcorder logfile.

❖ B: Finding calls and creating measurement files.

❖ C: Statistical species identification using batIdent. Import of identification results in bcAd-
min as well as control of results. Data summarisation as well as raw data can be exported 
in various formats. This step is only necessary, if you do not use the new CoreML based 
identification tool built into bcAdmin4

bcAdmin manages and saves all entries and results for sessions and recordings in a data-
base file with the extension bca4sql. When creating sessions, adding recordings and run-
ning their analysis it will read/write additional files:

❖ recordings; audio files from your recorder
❖ LOGFILE.TXT; batcorder logfile with runtime informations logged by the batcorder
❖ call files .bcCalls; time-frequency measurements of all calls of a recording
❖ measurements .csv; measurements taken for batIdent id process
❖ result files .res; batIdent result files
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The logfile is used for automatic import of recordings and their organisation in sessions. 
The recording files are read when the call finder is started as well as when time stamps 
and recording lengths are read in. If you store files on a slow medium or on a network 
drive, the access will be slower than if stored locally or directly connected hard disk.

The call files are used to display the call preview in the File Browser and thus read 
whenever a call display is required. Measurements are used by batIdent which creates the 
.res files for results import into bcAdmin. The best approach is to organise all files belong-
ing to a single session within their own unique folder.

5.2. Import from logfile

For creation of sessions and import of recordings the best approach is to utilise the import 
from logfile feature of bcAdmin. That way recordings are copied (if necessary) from SDHC 
card, sessions are created and recordings added. All available information from the logfile 
is automatically entered into the database. This means you get start and stoptime as well 
as batcorder settings created within bcAdmin automatically.

The following entries of a session are created automatically when importing from logfile:
❖ Session-identifier: batcorder filecode is used
❖ Sample date: start/stoptime and sampling time are taken as recorded by the batcorder
❖ filelocation: filelocation is set to the folder the recordings are imported from or copied to (if 

logfile resides on the sdhc card)
❖ batcorder-settings: the settings threshold, posttrigger, 

quality and critical frequency are set

Import of files from SDHC-card
Whenever a batcorder SDHC-card is inserted in the com-
puter, bcAdmin recognises it and activates the SDHC 
toolbar item in the upper right of the window. Using this 
button you can import files or format the SDHC-card. Op-
tionally choose the appropriate import command from the 
menu Sessions. When starting the import the logfile is 
read and analyzed and the results are displayed. For box 
or wind turbine kits the average GSM quality is indicated 
(the number of tries for sending an SMS are counted). 
There are various errors within a logfile that are ignored 
here, yet important information like sd card defect are in-
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dicated in the import process. The import dialog list all extracted sessions in a table. For 
each session available information are shown. In addition a symbol indicates the usage 
mode of the batcorder and gives hints if the sd card is out of memory or the battery empty:

If a logfile problem was indicated for some sessions not all recordings may get copied. You 
should check manually, if the recordings were copied completely. If such error occur regu-
larly, please exchange the SDHC card.

The dialog allows to select which sessions to import. You can additionally already set pro-
ject and/or location for all sessions. Since the files reside on SDHC-card, you have to set a 
folder the files should be copied to before importing them. Check each session you want to 
import using these settings and start the import. That may take some time, depending on 
the number of files that have to be copied to disc. If you have the files already copied to 
disk before starting the logfile import, you can op out of copying the files. Make sure, you 
do not opt out when import from sd card. Otherwise the files will not be accessible after 
ejecting the sd card.

Import from logfile on hard disc
If you have already copied your recordings to hard disc, you still can use the logfile import. 
Note that the logfile and the recordings have to be located in the same way they were 
found on card. If you introduced subfolders, the logfile import may not be able to find the 
recording files.

You can start the import via Sessions -> Import from logfile. Next a file chooser dialog 
appears and you have to select the logfile you want to use for import.

The procedure to import files is as described above. The only difference is, that you‘ll not 
need to set a filelocation for copying files to. If you want bcAdmin to organise the file struc-
ture, you nevertheless can activate file copy.

When recordings get imported that way, their timestamp is set from the file creation date. If 
files were copied to hard disc, they may have received a new timestamp. If that is the 
case, you can later extract the correct timestamp from logfile.

AUTO mode wind turbine kit

AUTO+TIMER mode box extension

logfile problem
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Import per drag&drop
Starting with bcAdmin 4 1.0.50 you can drag files from a Finder window and drop them on 
a session. This will import the files if filelocation is not already set for the session or the 
filelocation is the same as where the recordings reside on disc.

Folder import
You also have the possibility to import multiple logfiles from within a folder tree. This 
proves useful if you have collected data over a season from multiple devices and have 
them stored on your hard disk already. This way you choose the parent folder within which 
the various logfiles and recordings are located. bcAdmin will collect all logfiles int he folder 
tree and show an import panel per logfile automatically. The folder tree must be similar to 
this:
Parent folder ->

SD-card1 ->
Logfile.txtx
Recording folders (created by the batcorder)

SD-card2 ->
Logfile.txtx
Recording folders (created by the batcorder)

SD-card3 ->
Logfile.txtx
Recording folders (created by the batcorder)

Import of Batlogger recordings
While you can add Batlogger wave files manually there also exists an import analogue to 
the log file import. Select folders with Batlogger recordings, created per night. You may 
have to change the Batlogger settings to create a folder per night. bcAdmin will read the 
Batrec.log in the root folder of these nightly folders and automatically create sessions for 
each sampling night. The according recordings are automatically imported. bcAdmin will 
always try to evaluate the batlogger .xml files created per recording. These usually contain 
temperature and coordinates.

Note that a previous import of files to BatExplorer 2.0 will change the folder structure. A 
regular import to bcAdmin 4 is then not easily possible.

5.3. Import of folder structures

The command Sessions -> Folder import allows importing any existing folder structure 
from your hard disk. If bcAdmin 4 finds a Logfile.txt in the progress it will ask if to use it. 
Otherwise all selected folders are checked for recordings and if any are found, a session 
for import is created. Note that the folder import does not deep traverse through your 
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folder tree. Using the folder import you can import the selected folders at one level. Set-
tings for the newly created sessions can be chosen.

5.4. Manual creation of sessions and recordings

There may be situations when you can‘t use the automatic import of sessions and record-
ings. For example if you have a collection of non-related files or if you are using another 
recording device that doesn‘t create a logfile. We recommend you setup a session with 
necessary information and add recordings to it manually. That way you can use all or most 
of bcAdmin features with these recordings.

Create a session
Either press the create session toolbar item (the batcorder symbol) or choose Sessions -> 
Add to create a new session entry. Also note that you can duplicate existing sessions to 
get a starting point. It will have most of the source sessions details filled in already.

Note: Duplicating a session will neither duplicate the files nor the filelocation.

Next set a correct filecode or identifier and set the correct sample date. Also make sure 
start- and stoptime are set. If necessary adjust the batcorder settings so they resemble the 
actual settings of your batcorder.

Add recordings
After you created a new session it should be already selected in the table of sessions. You 
can then add recordings either via the toolbar item or via the Session or Recording 
menu, or by dragging files from a Finder window onto the session entry in the middle table.  
If there is already a filelocation set for the session that differs from the filelocation of the 
added recordings you‘ll get a warning and the process is stopped. Please first set the ses-
sion filelocation to the folder the new recordings are located at. bcAdmin supports only raw 
and wav files.

When importing recordings the timestamp in the database for each recording is taken from 
the file creation date. This may have been changed due to emailing, copying or uploading 
files. If you still have a logfile at hand, bcAdmin will be able to reset the timestamp from 
there. For some wav recordings you will be able to extract recording time from the file-
name.

5.5. Finding calls

After adding recordings initially the recording stable list only a few entries, but no informa-
tion on count of calls or species. Only after you initiated the search for calls, you will get a 
number of calls found, if any were found. Also you‘re able to see calls in the File Browser 
now. The call finder works on all selected recordings.

Tip: Select all displayed recordings by pressing cmd/⌘ and A.

Manual bcAdmin 4.0 Version 1.4.4 - Page 15



The algorithm to find calls and extract measurements is lightning fast, and unique. Most 
settings for this algorithm are set to an optimum value, optimised for batcorder recordings. 
Still, as user you can and should change the threshold according to your recordings, which 
equals the sensitivity. The threshold, thus call finding sensitivity, can be set at various 
places. Note the value is given as damping value in dB. Thus a value of -27 dB is less 
sensitive than a value of -30 dB. 0 dB resembles a full strength signal.

The basic setting for threshold is preset to a per session value, so when accessing the 
threshold bcAdmin uses the value set in the session details. All files of a single session will 
thus be analyzed with the same threshold value. You can also set a general application 
wide value. That is used only, if you choose to ignore the session value. This can be set in 
the application preferences. There you can also choose to use adaptive call intervals. This 
feature allows to improve call measuring when echos and calls overlap. Often this hap-
pens with Nyctaloid calls and pipistrelloid social calls are detected. Setting an adaptive call 
interval of factor 3 to 5 allows to solve this situation quite often giving better identification 
results. At the same settings panel in preferences you can also choose a parallel call finder 
which is quicker than the serial call finding algorithm. You may adjust the number of simul-
taneous  operations there. Note that depending on the recording storage too many parallel 
calculations may slow down due to limited bandwidth for disk access. In addition you can 
choose to search for calls in background, thus you can continue working in the open data-
base. We do only recommend this for advanced users.

5.6. Influence call finder

The threshold setting as well as the adaptive call finder algorithm is in the first step of the 
call finding process. Thus these two options will eliminate calls at the level of finding calls. 
There are other advanced options that make use of plausibility controls and will eliminate 
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calls not being plausible only after the full measurements are taken. They are explained in 
a later chapter together with the other advanced / expert settings.

5.7. Results-Import

Starting with bcAdmin4 1.4.2 you do not need batIdent for classification anymore. bcAd-
min4 comes then with a built in classifier based on CoreML using updated reference calls. 
You once have to activate CoreML usage within application preferences. The option is loc-
ated in the Call finder sheet. The following paragraphs are only valid if you want to use 
batIdent.

After a successful call search species identification using batIdent can be started. You 
need to have installed and setup batIdent for this.

Either navigate from batIdent to the folder containing the corresponding recordings or 
right-click on the selected recordings and choose Identify bat from the menu. For this bat-
Ident has to be activated as service via the System Preferences of Mac OS X.

batident will create a res file for each recording and also add per call results to the bcCalls 
file. That way you‘re able to see per call id results in the FileBrowser. To display the results 
in the recording table, you‘ll have to import results for the selected files.

Another word on activating the service Identify bats:

To go directly to the system preference that maintains the list of services, choose within 
bcAdmin -> Services and there choose Settings. A dialog opens displaying a list of 
available services in the right column. Scroll down and check identify bats. Now bcAdmin 
should be able to communicate directly with batIdent.

5.8.Edit species entries

In the recording details view various information for the selected recording are displayed. A 
table shows the species identified with CoreML or batIdent. You also see the probability as 
well as the previous step in the id process. Using the + button you can manually add a 
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new or replace an existing entry. Manually added entries get a probability of 0% so they 
can be identified again easily.

Using Recordings -> Batch replace species entries for a range of selected species can 
be removed, added or exchanged automatically. 

We highly recommend to use the following op-
tion  when editing species entries. It is the fast-
est and most streamlined way of doing it. Spe-
cies can be set using the number keys (1 to 0) 
as well as the number keys + cmd-key. The 
corresponding species for each number can be 
set in the taxa editor. The key assignments can 
also be displayed in the file browser by pressing 
the k key. By pressing the number key either in 
file browser or in the main window the existing 
species entry for the recording is written over. If you want to add a species, you have to 
hold the alt key . Using the key combination ctrl + 0 deletes any species entry in the se-
lected recording. These key commands give you the possibility to correct identification 
results for multiple recordings very quickly.

5.9. Call display and File Browser

One of the new features of bcAdmin4 is a direct call display integrated into the main inter-
face. You can thus quickly see a sonagram and measured calls when browsing the table of 
recordings. If multiple recordings are selected only calls are shown and the sonagram is 
hidden. With multiple recordings you can click on one of the recordings and select this one 
for detailed analysis. A small circled arrow in the top right of the call preview allows you to 
switch back to the last selection. Holding down the shift key while clicking a recording in 
the call preview will deselect this recording. That way you can quickly assign new species 
based on calls of multiple recordings and can exclude single recordings within the selec-
tion beforehand.

A right click on the call preview allows to adjust settings 
like maximum frequency in display, style of frequency 
bands apart other from settings. You can also define 
bcAdmin behaviour when more than 300 calls are se-
lected for display. It can be set to not display call num-
bers of 300 or more to speed up working with multiple 
selections. 

Using the File Browser you can quickly display calls 
and an overview sonagram of selected recordings as 
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well as a sonagram of single selected calls. Open the file browser using the corresponding 
toolbar item or the command Recordings -> File browser. After selecting a recording in 
the main window the Enter key will also open the file browser. 

In the newly opened window you see a display showing the measurements per call (fre-
quency over time; call intervals are cut-out) as well as an overview sonagram (upper 
graph). This displays up to four seconds of sound (see preferences). Using the arrow keys 
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on your keyboard you can move up and down the recordings table and quickly scan your 
recordings. If batIdent already identified species, you can see below each call an entry 
displaying species and probability for this single call. Additionally the sounds are displayed 
as sonagram above the calls. Intervals are shown as well in the sonagram. The sonagram 
is always stretched to fill the window width. 

Note: The results should be read as per call results and not be interpreted as the id result 
for the file. The results of each single call are accumulated and an overall result is calcu-
lated. What you see for the per call results is typical for statistical noise, thus species 
showing up that you may not have expected.

Navigation through recordings is possible using the arrow buttons as well as the arrow 
keys on your keyboard. This allows you to screen a large number of recordings very 
quickly. It helps to control the quality of identification and find sequences with social calls 
or feeding buzzes. By clicking the play or speaker button below the call display you can 
playback either in ten-time delayed mode or with a virtual heterodyne detector (also by 
pressing p).

To the lower right a sonagram of the selected call 
is displayed. The red line indicates the frequency 
with most spectral power. Sonagram parameters 
are chosen based on call length and are fixed. By 
right clicking on the preview call sonagramm you 
can change the colors of the sonagram. Using a 
mouse left click and hold you can drag a meas-
urement display to manually measure call values.

Starting with bcAdmin 1.0.40 you can display reference calls. After right clicking on the call 
display choose reference calls display.

Key shortcuts
For quickly changing or setting a species for the selected recording, they keys 1 to 0 and 
cmd+1 to 0 can be set to a species. That way, when manually identifying a species using 
the file browser (or while working in the recording table!), you can quickly set its spe-
cies entry. If you want to add a species to the existing entry, you can press the alt key and 
the corresponding number. The maximum number of three species per recording can not 
be circumvented that way. In addition the key combinations m, c and u toggle the marked, 
checked and unsure state of the selected recordings. All key combinations can be dis-
played by pressing the k key. The taxa keys can be assigned per document in the taxa ed-
itor.
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Neuronal network for species id
In bcAdmin4 1.2.4 a preliminary tool Neuronal id was added to use the sonagram of a call 
for species identification. This is a rather preliminary tool that currently only supports the 
group Nyctaloid. It can be started using the respective button (bat+question mark). An im-
proved tool is available already in bcAnalyze 4 Pro.
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6. Sessions
To allow a quick and simple working with the application, most data can be accessed and 
changed easily. All session details are accessible easily after double-clicking a session 
entry in the session table. A popup displays all session details and allows editing all in-
formation. More elaborate functions let you access the logfile, delete or add recordings 
and remove location or project connections. These are accessible via the Session menu.

6.1. Editing Sessions

In a previous chapter detailed instructions were given on how to import sessions manually 
or from logfile. Since not all settings for a session may be available at its creation time, it 
may be necessary to add details later:

Filecode: This acts as name of the session and forms a unique identifier together with the 
date. Usually this set to the same value as on the batcorder. If you use other recording 
devices, you can code a location or project here.

Date: The date the sampling began. Acts as sample date throughout the application.

Project: Sessions can be grouped in projects.

Status: Sessions can be marked with a status or flag.

Sampling from / to: Timestamp for start and end of sampling. Is used by some functions 
for calculating activity indexes.

Editor: You can add the person responsible for data collection here.

Filelocation: At this folder all recordings and related files are searched for. By unlocking 
this field you can change the filelocation, for example after the recording files have moved.
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Furthermore these details can be set per session:
Location: This dropdown gives a list of available locations to connect the session to. If you 
have already chosen a project for this session, only locations already connected to ses-
sions of this project are shown. You can show all locations.

Sunset/-rise: Timestamp for sunset and sunrise. These are used for some graphs as well 
as for some calculations and should be filled in after best knowledge. If a location with co-
ordinates was set these values can be calculated.

Rain, Temperature: Both types of values have no special input format and are currently 
not used by other functions. They are more for your own reference. Since the batcorder 3 
does automatic logging of temperature while recording bats, the values get extracted 
automatically when importing recordings via logfile. You can get a graph showing the tem-
peratures over night. If temperature data is available a small icon with a thermometer is 
displayed. This acts as button to open the temperature graph.

Environmental data: If environmental data is connected to a session, this is indicated 
here. You can also choose a different set of environmental data. The setting is used for the 
correlation tools to give default data to each session. The environmental data object is 
generated automatically when importing data from logfile and if the logfile contains bat-
corder temperature measurements.

Comment: Any comment for this session can be added.

batcorder-settings: If you‘re working with the batcorder, your settings should be added 
here. For other recording devices or file formats, the corresponding samplerate should be 
set. Depending on the recording quality, you may adjust threshold and quality settings.

6.2. Managing sessions

Selected sessions can be edited per double-click. Selection of multiple selection is pos-
sible by holding down cmd key when selecting. If you want to select a whole continuum of 
sessions, select the first, then hold shift key and select the last one. If more than one ses-
sion is selected, most actions operate on the multiple selected sessions.

After some time of batcorder usage you may find your list of sessions grown a lot. Thus, 
finding sessions may get painful. bcAdmin offers some ways to speed up finding sessions.

Sorting
Sessions can be sorted according to various criteria. Click the session column header and 
select the sort parameter you want.
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Filter
You can quickly filter sessions by type of session (auto, timer, ...) using the drop-down 
above the session column. More complex filters can be activated in the left sidebar. You 
create filters analogue to projects, thus by using the buttons below the sidebar. Filters act 
dynamically, thus whenever activated by clicking, they perform their filter and filter from all 
sessions those that fit their predicate. After creating new sessions you will have to reactiv-
ate/reselect the filter to see changes.

When creating a filter you should give it a label first. Then you can choose from a variety of 
fields that can be used for the actual filter process. An explanation of what you can use as 
filter criteria for various field types follows:

Date entries: You can use filters with daily accuracy.

Strings: Most fields contain string values. Various criteria for filtering strings are available 
including equality, difference, starting with, ending on etc.

Boole values: They can be set to wither Yes or NO, or 1 and 0 respectively.Fields like 
marked or audited belong to this type.

Numbers: All values that resemble numbers can be tested for equality or smaller than, 
larger than, ...

For some fields special ranges of values account:

Details: moon: The value for moon is listed as percentage in the session details. It is thus 
stored as value ranging from 0 to 1.

Recordings: classification: Recordings can be classified according to four different 
types. Standard is 0 = no classification. Other values are 1 = normal calls, 2 = social calls 
and 3 = feeding buzz. Please enter the respective number when filtering sessions that in-
clude such recordings.

Above the filter criteria you can in addition choose how criteria are combined and used.
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6.3. Temperature data

If the same environmental data is connected to all selected sessions you can display a 
temperature history. In addition file numbers or seconds of sound recording are displayed 
as bar chart.

The red line indicates daily maximum while the blue line shows the daily minimum temper-
ature.

6.4. Archive sessions

A new feature of bcAdmin 4 is to archive sessions. This will create a zip of the session file-
location and is useful to save space on hard disk. It only works well if per session a single 
folder exists and the files are not used by another session as well.  You can archive the 
selected sessions using the menu Sessions - > Archive session files. Archived sessions 
are displayed with blue color in the session table. If the zip file stays at the location where 
it was created bcAdmin can still extract sound files and call values from the archived files 
for display. Only changes that create new files are not possible anymore.
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6.5. Filtering sessions

While you can use projects to manage sessions according for example to your field work 
projects, you can also use filters to dynamically filter all sessions in your database. That 
way you can quickly create a subset of sessions according to a large number of filter criter-
ia. Filters are created with the same button that projects or project folders can be created. 
This button is found in the lower left corner of the main window.

Upon creating a filter a dialog is shown allowing you to choose from a long list of paramet-
ers for filtering the sessions. You first can choose if all criteria must be met or of any of the 
criteria should be met (ALL/ANY). Next you choose the parameters and set the filter cri-
terion. This is rather intuitiv and can be changed later again when double clicking a filter.

If you have created a filter that produces an error, for example due to changed data, 
bcAdmin may crash. For such situations we have added a feature that allows selection of 
filters without starting the criteria This can be done by holding alt/option key when select-
ing such a crashing filter.

6.6. Changing the filelocation

The correct filelocation is important to find the files belonging to a session. They are 
needed when searching calls as well as when displaying call displays. Sessions with a 
missing filelocation or an invalid filelocation are shown in red in the session table. When 
you are moving a folder with recordings, the sessions pointing there will be drawn in red. 
You then have to adjust the filelocation, otherwise the files can‘t be accessed from bcAd-
min. If you have to adjust the path for multiple sessions, bcAdmin will help you as much as 
it can. It will first determine the common path of all sessions. As long as you have stored 
and moved recordings in a parallel way, so not randomly, this should be good enough. 
bcAdmin will allow you to exchange the common old path with the new filepath the ses-
sions have in common.

An example:

Sessions with FILECODE_A, FILECODE_B and FILECODE_C store their recordings in:

/Volumes/Macintosh HD/User/batcorder/Recordings/130601

/Volumes/Macintosh HD/User/batcorder/Recordings/130605

/Volumes/Macintosh HD/User/batcorder/Recordings/130610

The common path thus is:

/Volumes/Macintosh HD/User/batcorder/Recordings
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If you move these folders to an external hard drive as follows

/Volumes/EXTERN/Recordings2013/130601

/Volumes/EXTERN/Recordings2013/130605

/Volumes/EXTERN/Recordings2013/130610

That way the old common path from above will be exchanged with:

/Volumes/EXTERN/Recordings2013

This method of path replacement is always possible, if multiple sessions are selected 
when the session details are opened.

6.7. TSL-evaluation

The microphone test recordings of box and wind turbine extensions as well as the GSM-
batcorder can be analyzed to check for correct microphone sensitivity. For this test the re-
cordings have to been imported using logfile import from SDHC card. That way the micro-
phone test signals are specifically labelled and can be accessed automatically from bcAd-
min. The plotted graph shows the results of RMS measurements within the test signal. 
Since the reference value taken when implementing the batcorder in the field is not known 
to bcAdmin, you have to read the graph by looking at the average RMS. From the average 
two lines showing- 3 dB and- 6 dB are plotted in yellow and red. Values outside the -6 dB 
range indicate mic problems.
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6.8. Combining sessions

This feature allows to combine two session in 
such a way, that duplicate recordings (based on 
time stamp) are removed in the resulting com-
bined session. This for example is useful when 
you have recorded at two similar and close loca-
tions and want a combined dataset of bat activity. 
Usually this feature is used with a selection of 
multiple sessions. These must reside in one pro-
ject. The other set of sessions, mirroring the first 
set by days, must be inside another project. The combination dialog after selecting the first 
set of sessions then allows to choose the project with the second set. You can also choose 
the time interval allowed between two recordings to still count as one pair.

For running the combination process you best have a third empty project for adding the 
newly created sessions to. The newly created sessions are marked by a C- in front of the 
original filecode. Virtual recordings, that mean those added from the second session set, 
are displayed in italic.

Manual bcAdmin 4.0 Version 1.4.4 - Page 28



6.9. Comparing sessions

Another feature for working with larger datasets is the session comparison tool. It works 
with two up to four single sessions as well as a batch mode for sessions organized in pro-
jects. It allows to visualize activity identical as well as different in time between various 
sessions.
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7. Recordings
There are many methods in bcAdmin making management of your data easier. While most 
information is stored within the database for fast access, the raw recording files and all de-
rived files are saved at the sessions filelocation. Some of the following functions need ac-
cess to the files to work properly. Others can work on the database alone.

7.1. Recordings table

The main interaction with recordings is done using the recording table in the main window. 
It displays apart from filename and recording time many other meta information for each 
recording. Using the application wide preferences you can choose visual display of 
marked, unsafe or audited recordings. In addition the preferences allow to colorize all re-
cordings belonging to a single time period defined by a choosable time interval. Apart from 
activating this feature in the preferences the table has to be sorted by recording time.

On right clicking the column headers you can select or deselect columns to alter the table 
display.

A new feature of bcAdmin 4 is the display of a call and sonagram display for the selected 
recordings. The calls are displayed if calls were found and saved as bcCalls file. If you se-
lected multiple recordings all calls are shown. You can set a preference to explicitly only 
show up to 300 calls since rendering too many calls may slow down the app. Sonagram is 
only shown if a single recording is selected.

7.2. Recording details

The recording details allow to set details for each recording entry in the database. You can 
open the detail view by by clicking the small buttons in the lower right of the recording 
table. Each recording entry can be classified as normal sequence, social calls or feeding 
buzz. Apart from social calls of pipistrelle this will not be done automatically, but can only 
be checked manually. The comment field can be used for any kind of comment like for ex-
ample your own guess regarding species.
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Note: classification and comment can be set only for the whole recording entry, not for a 
single species entry. 

Using the mark checkbox you can mark a recording to find it easier again. A checkmark for 
audited means, the recording result was manually controlled. There also exist buttons to 
open a file in Finder, with a sound tool like bcAnalyze or in the call preview of the file 
browser.

7.3. Filtering recordings

By clicking the columns headers the whole table can be sorted using the according 
column. In addition you have the possibility to filter using a couple of criteria listed above 
the recordings table:

Mark.: only marked (see recording details) recordings are shown, the control switches to 
Unsafe, Audited and negation of these with consecutive clicks. Holding shift while clicking 
quickly disables this filter again.

Count 1 / 2 / 3: only recordings with the according number of species are shown

Species: Only recordings with the selected species are shown. When holding shift while 
selecting a species, the species is filtered out.
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Group: Only recordings with the selected group 
entry are shown. When holding shift while select-
ing a group, the group is filtered out.

Class: only recordings with the corresponding 
classification are shown

Prob: only recordings with the corresponding probability are shown

Custom: custom filters allowing to filter by recording time and other values

Note that the filter stays active even when you select an other session or dataset. Active 
filters are indicated by a red background of the filter bar. You can remove all filters using 
the x button on the right end of the filter bar.

The filters can be saved by right clicking on the colored filter bar and choosing to save the 
current filter. Saved filters are available throughout all databases and can be deleted again 
by choosing to manage the filters.

The additional custom filters are available by clicking 
on Custom in the filterbar. These allow certain filters 
based on recording time. For some the sessions need 
to have set correct sunset and sunrise time entries. 
These extra filters are useful when dealing with large 
datasets from long term monitoring as for example 
from wind turbine assessments.
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Another new filter is based on measurements of each call. For this filter the recordings 
must be available on disk as files and measurements have to be created by the call finder. 
To activate the call measurement filters, you need to double click any entry in the Calls 
column.  In addition the filters can be activated from the menu Recordings -> Select call 
parameters. Another filter in the recordings menu will filter a random number of record-
ings.

7.4. Managing recordings

Copying and deleting original files
You can delete recording files displayed in bcAdmin directly via the according menu items 
in the Recordings menu. Deleted files are moved to the system trash and can be restored 
from there again.

Managing database entries
Using Sessions->Add recordings or Recordings -> Add recordings new recording files 
can be added to bcAdmin. They will be added to the current selected session. You can‘t 
add recordings from different filelocations to one sessions, though.

7.5.Feeding-buzz detector

We do not believe that feeding buzzes are a reliable marker for hunting behaviour - or the 
absence of feeding buzzes for no hunting behaviour. Yet bcAdmin 4 features a detector for 
feeding buzzes in selected recordings. It is available from the Recordings menu.
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7.6.Find trigger events

Sometimes you have recordings covered by a lot of artificial noise or bushcrickets. In such 
situations the call finder may not be able to find all calls. Using the trigger finder may allow 
to find some more recordings with positive trigger events that were not good enough for 
the call finder.

7.7.Parasite detector

Starting with version 1.3.5 bcAdmin 4 includes a parasite noise detector. After call search 
and batIdent/CoreML identification at some locations you end up with many Spec or Pip-
istrelloid recordings that are actually noise. The process of checking these can be cumber-
some. We have included an automatic tool based on machine learning. Select the relevant 
recordings and choose from the menu Recordings the option Detect parasites. Each re-
cording will be classified as Bat or „Störung“ (German for noise) and the result is written to 
the comment field. 

If you have recorded noise/parasite that the supplied method does not recognize as noise 
you can learn an adapted model. For this select the relevant recordings first. Make sure, 
they do not contain bat calls apart from parasite noise. From the Recordings menu choose 
to Export parasite (requires macOS 12). Using the application CreateCallsModel (down-
load on our homepage), you can create a custom parasite detector including our data as 
well as your noise data. The resulting model-file can now be used as an alternative to the 
built in classifier model. To use your own mode hold the shift key when starting the para-
site detector from the recording menu. You are then asked to choose your model file which 
is used for the parasite detection then.

7.8.Automatic species identification using CoreML

In bcAdmin4 1.4.0 we have introduced a new species identification tool which will replace 
batIdent this year. The first version is preliminary and does for now store its results in the 
recording comment. That way you can easily compare batIdent results and CoreML res-
ults.

The classifier is found in the recordings menu and you can either classify on genus/group 
level (only the first classification step) or on species level. The command takes the selec-
ted recordings and is doing an analysis. The process is ca. 5 times faster than the batIdent 
process, with higher speeds on the optimized Apple computers with M processors.

For optimal results of the new CoreML classifiers we recommend to adjust the call finder to 
eliminate such calls deviating from the regular calls. This can be activated in the applica-
tion Preferences -> Expert settings. Choose to filter noise using statistical analysis and al-
lowing only such calls with a median as criterium within 100% bandwidth.
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Since version 1.4.1 a new feature was added. In Preferences -> CoreML you can set indi-
vidual probability thresholds for genus/species which must be met to add a call to results 
and output a final result. For a better understanding of these thresholds we explain in 
short, how the classification process is working and where these probabilities are effect-
ively used.

1. Classification on genus/groups level: In a first step for each call the genus (group for 
nyctaloid calls) is evaluated. The classifier gives a result and a probability. If the prob-
ability reaches at least the threshold set for the result (standard 0,8 = 80%) the result is 
stored for this call. If the criterium is not met, unspecified Spec is stored.

2. Classification on species level: The next step classifies the call on species level. The 
classifier again gives a result and a probability. If the probability reaches at least the 
threshold set for the result (standard 0,8 = 80%) the result again is stored for this call. If 
the threshold is not reached, the last result (genus/group) is kept.

3. Final result for recording: The results of all calls are combined per genus/species are 
sorted by probability and count. For each result the probability must reach the threshold 
to qualify as final result for the recording. These results are then reported.

The preference window gives two fields per genus/species holding the single call threshold 
in the first and the overall threshold in the second field.

In bcAdmin4 1.4.2 the results can now be directly used instead of batIdent results. You 
only have to activate this option once in preferences -> call finder. There you can opt-in to 
still produce the csv-files used by batIdent. The new CoreML classifier works without the 
csv files as well.

7.9.Recording distance

If your detector has a known sensitivity you can calculate the distance the calling bat had 
to your detector by assuming a call amplitude for the bat. Using this tool will not give exact 
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distances to the calling bat, but it will help to estimate the range you were recording the 
bats at. You start the distance finder from the Recordings menu using Plot distance.

For the batcorder you can assume 96 dB full scale at 40 kHz when properly calibrated. If 
your detector of another brand is calibrated, you should have a value for full scale as well. 
Bats can be expected to use sound pressure levels of  90 dB (whispering bats) up to 130 
dB SPL.

7.10. Changing timestamps and durations

Changing timestamps
The timestamp for each recording is extracted from the file creation timestamp when the 
files are imported to bcAdmin. This timestamp may not be correct if the files were copied, 
sent by email or otherwise moved between different media. Thus it may be necessary to 
change the timestamp to the correct one. Various commands exist for this task. You can 
use Recordings - Adjust recording time to add or subtract a certain amount of hours, 
minutes and seconds to the current timestamps. With Recordings -> Adjust time from 
logfile the logfile is read and timestamps are extracted from there for each recording. Fur-
thermore a feature exists for SM2Bat and Avisoft recordings that store the recording 
timestamp in the filename.

7.11. Simulate batcorder

You have the possibility to simulate a batcorder with different settings based on the selec-
ted recordings. This enables you to switch parameters if you have mistakenly used differ-
ent settings when recording. Note that only some simulations are possible:

Posttriggeroriginal >= Posttriggersimulation    e.g. 600ms batcorder vs. 200ms simulation

Thresholdoriginal =< Thresholdsimulation       e.g. -36 dB batcorder vs. -27 dB simulation

The results are stored using virtual recordings in your session indicated by italic print of file 
name. All other aspects like duration, species etc. are copied from the original recording.

7.12.Export as wave file

Selected recordings can be exported as wave files using Recordings -> Save as Wave. 
This may be useful if batcorder files have to be sent to someone not being able to open 
raw recordings. The exported files get the timestamp of the database entry.
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8. Managing environmental data
When analysing bat activity environmental parameters like temperature or windspeed 
influencing the activity are often of interest. In bcAdmin4 these can be imported and stored 
in the database as extra objects and then be used for various analyses. You can open the 
editor from the Window menu using Environ data.

Administrate and import environmental data from there and store windspeed, temperature, 
rainfall, energy and coordinates within a single dataset. Coordinates are managed from 
the maps view where they can be used for geo referencing. When importing from logfile, 
the stored temperatures from the batcorder are imported as environmental data and stored 
with the according FILECODE. Simple analysis allow to see time gaps in data as well as 
various statistics.

The import of CSV files is one of the main tasks of the environmental data editor. If you 
want to add data to an existing dataset, choose the main dataset in the first column, then 
use Import. Otherwise a new main entry is created. After choosing the csv file for import 
next choose the appropriate settings to import single columns and timestamps from the 
CSV file. Display of either raw data or a table is possible indicating by bold text the 
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imported data. Note the correct time format as well as the deviation of GMT for the data is 
needed.

Timestamps can sometimes be a bit tricky. The optimal solution is that date and time are 
stored in a single column. Otherwise check the box that time is stored in the next column. 
Choose from the presets the format that describes exactly the given timestamp format in 
your csv file. Make sure, all rows feature exactly the same timestamp format. While 
bcAdmin will recognise most formatting errors itself, there can be situations when you get 
wrong timestamps returned. You later can adjust the time base (GMT offset, timezone) 
after selecting any of the contained datasets (temperature, windspeed, …).

You can examine various properties of the data like time gaps, minimum and maximum as 
well as the distribution of data by using the various buttons. A new analysis gives a graph/
heatmap for temperature or windspeed throughout the year with various options to 
customise the display.
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Environmental datasets can be connected to either sessions or locations and then be used 
in correlation of activity with weather conditions.
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9. Data analysis
bcAdmin contains various tools to analyse your data for different goals. You are able to 
create meaningful activity summaries and graphs for your reports. Usually the following 
tools work on data of the selected sessions.

9.1. Species list

This feature gives a list of all species encountered at the selected sessions. Additionally 
sessions can be summarised based on various parameters like project, location or various 
date parameters. Based on averaged probabilities bcAdmin creates a probability for each 
species/group entry and indicates this with different symbols (filled circle high probability, 
empty circle Lowes probability). For this a weighted average over all species entries is cal-
culated. Species with only a few entries may thus be more easily classified as of lower 
probability. The result can be saved as image or CSV file.

9.2. Activity report

The activity report is a powerful tool for comparing the data of various sessions or sample 
efforts. You create an activity report using Analysis -> Activity report . The report lists 
after its initial run for each selected session a column and a row per species/group entry.  
Sessions can be grouped using date, project or location entries. Data can be summarised 
in form of count of sequences, recording durations in seconds as well as activity in one-
minute classes. Some entries can be normalised based on sampling or night duration.  
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Choose to display species abbreviations, scientific names or groups for the species row. 
bcAdmin calculates the relevant entries in the table based on this selection. Next choose 
which data should be combined. You can show data for each session, for each date, for a 
week, month or decade as well as a mix of these with locations or projects.

The following activity indices are implemented:
❖ Seconds: The activity of each species per second (recording duration) is calculated
❖ Sequences: The number of sequences
❖ 1-minute classes: for each minute of sampling time with activity the minute count is in-

creased. Thus, all sequences of the same species recorded within a minute count as one. 
Sequences that have a timestamp outside the sampling time are ignored. Thus check that 
session settings are correct before using this function.

❖ Free time class: You set in preferences your time interval for combining recordings
❖ Continuity: If multiple sessions or locations are combined (for example monthly activity), 

the continuity gives a measure of how regular activity occurs. It ranges from 0% (none) to 
100% (every session).

I addition all calculations can be averaged based on hours of sampling, nights, etc. using 
the popup button in the upper right.

For some of the above calculations suntimes and sampling times from the session entries 
are used. Make sure these are set correctly, otherwise you may receive wrong results.
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Export to CSV
The displayed results can be exported to a CSV file for import to graphing apps or other 
databases. The standard setting is that the table will get transposed for export, but you can 
switch that off in the app preferences.

Graphical display
After selecting the report options a simple bar chart can be opened using the button Show 
graph. Clicking on settings opens a dialog that gives options like species selection, axis 
labels or user defined maxima for the y axis. That way you can select certain species for 
display in the graph.

The species colors are taken from the values set in the taxon-editor. If you want or need 
other colors, change them there for the whole database.

A special plot is possible to create if you have selected continuity as displayed parameter. 
In this case a matrix is created giving circles for each species/group for each displayed 
time base (day, week, month, …). That way you can quickly see activity patterns of spe-
cies over the year.
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9.3. Species tree

The species tree displays the distribution of species identification for the selected ses-
sions. It resembles the steps batIdent went through to find species for the recordings. You 
can opt to display number, seconds 
or minutes of activity per tree ele-
ment. The numbers are also coded 
using either small bars or pie charts, 
you can chose between those two 
displays. In addition the average 
probability for each tree element can 
be plotted. The graph works well for 
showing diversity as well as for find-
ing identification errors by looking at 
the numbers shared between similar 
calling species or groups.
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9.4. Nocturnal activity

For various reasons it may be helpful to examine activity at a location throughout one 
night. Emerging patterns may indicate roosts, or other bat relevant structures. For single 
as well as multiple sessions bcAdmin offers the display of nocturnal activity. It can be ac-
cessed via Analysis -> Nocturnal activity after the relevant sessions were selected.

Activity is displayed as bars in a histogram like way. The bats can either represent number 
of sequences or seconds of activity per bin. You can adjust the bin width from 5 to 60 
minutes. The background can be filled to indicate night or sampling duration. To allow bet-
ter comparisons of different nights, you can also set the displayed time frame. Single spe-
cies can be plotted as sub-bars by clicking the eye symbol next to their name in the left 
column. Finally the display of either species, genera or groups can be toggled. For export 
a legend can be toggled using the small legend icon in the upper right (only visible if spe-
cies are coloured). A right click on the graph shows a context menu with options to set a 
maximum y-axis value as well as graph subscription.

A new feature allows to batch export graphs for each session shown in the session table. 
To use it, select the first session, that should be saved as graph. Adjust the settings to your 
liking and then click on Save image while holding the alt/option key. Next choose a 
folder to save a image for each sessions nightly activity distribution.
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9.5. Yearly activity

If you are doing long-term monitoring your interest often lies in the activity pattern through-
out the year. This feature allows you to take a closer look at bat activity distribution split 
into daily and nightly patterns within one graph. It works for the selected recordings, thus 
you can easily display graphs for single species or all recordings. It is not meant as a 
graph to read accurate maxima and minima, but to give an overall impression of activity 
patterns. To draw the graph select Analysis -> Yearly activity after you have selected 
sessions and recordings. For better understanding of patterns the batcorder runtimes can 
be displayed in the background. They are taken from the session settings. Based on the 
coordinates sunset and sunrise are drawn as lines. If no location with coordinates was giv-
en to the sessions, a standard mid Germany location is assumed.

The sliders below the graph allow to change the color fill similar to a sonagram. To re-
semble a sonagram even more, you can activate a sonagram-like display as well. Export 
to  an image file for adding the graph to reports is possible as well.
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9.6. Frequency and probability plot

These two plots show the distribution of activity over night. One displays the batIdent 
probabilities for each recording, the other shows a selected frequency parameter for the 
selected recordings within the night. Both graphs help to identify possible misclassifica-
tions and overall give an impression of identification sturdiness. 

The graphs can be manipulated in various ways. When holding cmd-key you can select 
recordings by drawing a selection rectangle around measurements and zoom them full 
screen. By double-clicking while holding down cmd-key the graph is unzoomed again. 
When selecting measurements by a selection rectangle while holding alt-key, the record-
ings get selected in the recording table of the main window.

9.7. Call parameter plot

Another powerful tool to help identify misclassifications as well as to classifiy species your 
self without looking at all single calls is the call parameter plot. In form of a classic scatter-
plot you can choose to display two measurements, each on an axis. Typical pairings are 
duration and Fmod (which translates roughly to mean frequency) or duration and Fend 
(end frequency). Using the mouse while holding down cmd you can draw a selection rect-
angle to zoom in. Zooming back to normal is done by cmd+ double click. A right click on 
the graph allows to display some reference measurements of a limited list of species.

Using the clockwork symbol in the lower right you can activate a filter to eliminate calls in 
the display. If a filter is active this is indicated by red label below the plot. Furthermore 
point size and colors can be chosen. You can add a second reference species by clicking 
activating it while holding down the shift key. That way you can compare your calls to two 

Manual bcAdmin 4.0 Version 1.4.4 - Page 46



species at the same time. This often helps to sort out the species the calls you have recor-
ded belong to.
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9.8. Environmental correlation

One of the most complex features implemented in bcAdmin is the correlation of activity 
data with environmental parameters, mainly wind speed. This tool was developed to un-
derstand activity in relation to wind speed better and support the bat-friendly running of 
wind turbines.

Input data
The calculations are based on the selected recordings, thus, first select the recordings you 
want to run a correlation for. That way you can select recordings of all bats or of certain 
species. If you select recordings without species entry, these will be correlated as well. Us-
ing the recording filter capabilities helps to select wanted recordings quickly.

Next you need to select the environmental dataset containing the data for correlation. If 
you don’t have any imported yet, you can start the import here instead of in the environ-
mental data editor. You can also opt-in to use data stored with recordings, for example 
after a successful correlation.

You can do some checks on the environmental data before running the correlation. For 
example can you check time gaps or see the statistics of one parameter. In addition if us-
ing ProBat you can do a data validation beforehand.
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Correlation parameters
Last step before running the correlation is to select if results are given per species or per 
group level. Additionally select if a binary count (based on 10 minutes intervals) or the ac-
tual count of recordings is used for the correlation.

If you have already run a correlation before and have stored the environmental data with 
the recordings, a new correlation can be run using the stored values. This allows to create 
the graphs without choosing environmental datasets from the database.

Correlation background
After extracting the data range of the environmental parameter it is distributed evenly over 
60 bins (minimum to maximum). When correlating wind speed usually the range is set to 0 
m/s to 30 m/s resulting in 0.1 m/s bin widths. The current bin width can be seen in the data 
stored in the clipboard after a successful correlation or from the filter button below the 
graph.
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Graphs
The correlation results are shown as line or bar plot, raw data is saved to clipboard in addi-
tion and can be imported into other applications that way. The default line graph shows 
cumulated bat activity as percentage above the selected environmental parameter. For 
wind speeds 0.5 m/s classes are used, for temperatures 0,5° respectively. By either using 
the plots context menu (right-click) or the settings button various display parameters can 
be changed. When doing a left-click in the graph the area between the y-axis and the 
clicked point is filled with a different colour. That way you can for example click on the 95% 
of bat activity point and fill the part left of it indicating wind speeds that will be dangerous 
for bats. Finally you can switch between cumulative line display and a bar chart.

A new feature is to display a scatter plot with temperature and windspeed as axis values. 
You will need to correlate the recordings first with both these parameters and choose to 
save values. That way each recording gets a windspeed and a temperature assigned to. 
After activating the use of stored values of the recordings you can show the Wind+temper-
ature scatter plots.
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9.9. Curtailment analysis

Since 2022 a new feature to test curtailment algorithms for wind turbines was added to 
bcAdmin. This basically checks for selected sessions, if recordings are within or outside of 
a curtailement condition. These conditions can be either a rather simple form of either 
windspeed and/or temperature thresholds or detailed values per month or month and 
nighttenth.

The analysis will test for each recording if it is within our outside the curtailment and give 
results for the month of April to October. These are plotted in the display below the set-
tings.

In addition you can plot the distribution of wind speeds for the year and optionally add the 
bat events: 
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9.10.Data distribution analysis

With bcAdmin4 1.4.4 a new preliminary tool was introduced. The so-called Statistical re-
port is located in the Analyses menu. After selecting at least ten sessions it will give the 
distribution of the parameters count of recordings, sum of seconds or minutes with activity 
in the form of a table with data for boxplots or as boxplots in an actual graph. You can filter 
out data for species occurring rarely and thus not allowing a proper calculation of distribu-
tion parameters.

This analysis is useful to understand how your activity is composed in terms of temporal 
distribution. If you have single nights with high activity and mostly low activity nights that 
does give not only a distinct boxplot but also tells you a lot of the bat activity. In comparis-
on a single value like „average count of recordings“ may then be useless.

The graph can be exported to an image files as well as you can export the raw data dis-
played in the table.

We are currently investigating further features for this analysis tool to allow you to better 
describe bat activity in your projects.

Manual bcAdmin 4.0 Version 1.4.4 - Page 53



9.11. Within night distribution analysis

A new features starting with bcAdmin4 1.4.4 is the analysis of the distribution of time inter-
vals between recordings. A preliminary version can be tested and used already with the 
mentioned version. It can be found in the Analyses menu as item Night distro.

The basic idea is, that different patterns of bats occurrence relate to different types of 
activity. For example a bat hunting close to the microphone will produce series of record-
ings with short time intervals between these recordings. At a location with transfer flights 

only, the recording will be more isolated in time. While the analysis may be show noise due 
to the night duration being much longer than the typical activity of a bat at one location, it 
should already give hints at least for some recording locations.

The tool creates a histogram with a selectable bin width. That means you select how many 
seconds of time interval between two recordings one histogram bin should include. The 
analysis is done based on the visible recordings, thus any active filter is taken into ac-
count. If you filter for example Pipistrellus pipistrellus only these recordings will be used for 
analysis.
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10. Data export and synchronisation
You often will need to use data generated in bcAdmin in other applications as well. May it 
be for reporting or creating more special graphs in tools like R. Most of the tools bcAdmin 
offers already have the possibility to export the data generated and used in the tool itself. 
But sometimes you have your own analysis tools and for this exports of various informa-
tion are possible.

Exports are done to so called csv files. csv stands for character/comma-separated values. 
In such a file each dataset is stored in a row. The fields of the dataset are separated by a 
certain character - usually comma, semicolon or tab-stop. From application Prefererences 
you can adjust the default export options to csv format including field separator and 
timestamp format.

10.1.Raw data export to CSV

By using File -> Export to CSV you can export selected recordings and sessions to CSV 
in a very flexible way. The export dialog contains all fields that can be exported in the up-
per three groups of items. They are separated by session, location and recording. The 
fourth, lowest field acts as container for the actual export. Drag items from the above fields 
to the fourth to construct the export. You can save export selection and reload previously 
saved export configurations. Stored export configurations can also be set as default for 
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copy and paste from the session and recordings table. Thus, you can create a CSV string 
for the clipboard more quickly.

If you have selected species from the list of recording fields, you can chose if you want a 
new line for each species (if more than one is stored for a recording) or if all species 
should be within one line. The switch for this can be found in the applications preferences. 
This is a new feature of bcAdmin 3, in bcAdmin2 always a single line was written for each 
recording.

Note: Details regarding the CSV format can be all set in the application preferences via the 
Export display. There you can set column or field separator as well as line-ending.

10.2. Import of locations

Locations can be imported from csv files as well as from GPX-Trackfiles. Since a location 
always needs a unique name, when importing the data source already should feature a 
name for each location. Note the csv file must adhere to the following scheme:

4 columns with separator tab-stop, coordinates with . as decimal separator. The columns 
are

Date (optional), name, longitude, latitude

For example
019-06-22 Teststandort 1 9.515186221451565 48.74579048194715 
2019-06-22 Teststandort 2 9.115186221451565 48.34579048194715 

Date is optional and only used for sorting.

An example GPX file

<?xml version="1.0" encoding="UTF-8" standalone="no" ?><gpx xmlns="http://

www.topografix.com/GPX/1/1" xmlns:gpxx="http://www.garmin.com/xmlschemas/

GpxExtensions/v3" xmlns:wptx1="http://www.garmin.com/xmlschemas/

WaypointExtension/v1" xmlns:gpxtpx="http://www.garmin.com/xmlschemas/

TrackPointExtension/v1" creator="eTrex 20" version="1.1" xmlns:xsi="http://

www.w3.org/2001/XMLSchema-instance" xsi:schemaLocation="http://

www.topografix.com/GPX/1/1 http://www.topografix.com/GPX/1/1/gpx.xsd http://

www.garmin.com/xmlschemas/GpxExtensions/v3 http://www8.garmin.com/xmlschemas/

GpxExtensionsv3.xsd http://www.garmin.com/xmlschemas/WaypointExtension/v1 

http://www8.garmin.com/xmlschemas/WaypointExtensionv1.xsd http://www.garmin.com/

xmlschemas/TrackPointExtension/v1 http://www.garmin.com/xmlschemas/

T r a c k P o i n t E x t e n s i o n v 1 . x s d " > < m e t a d a t a > < l i n k h r e f = " h t t p : / /

w w w . g a r m i n . c o m " > < t e x t > G a r m i n I n t e r n a t i o n a l < / t e x t > < /

link><time>2019-07-08T14:51:55Z</time></metadata><wpt lat="50.12345" 

lon=„11.74522"><ele>350.170349</ele><time>2019-07-08T14:51:55Z</

time><name>Standortname</name></wpt></gpx> 
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10.3.Database synchronisation

With this feature you can synchronize or share data between two bcAdmin4 databases. 
For example if you and colleague are working on two parts of a larger dataset, you can 
synchronize the data into one database after both have finished analysis. Synchronisation 
is possible on the level of projects, sessions or recordings.  
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11. Preferences
The behaviour of bcAdmin can be fine-tuned using various preferences settings. They in-
fluence the call finder, CSV export or colours used within the application.

11.1. General

Choose the default folder for recordings and if project subgroups should be created auto-
matically.

Furthermore you can select the standard application to open raw and wave files for manu-
al analysis. In addition you can set the labels for session groups and some other details of 
how bcAdmin works in general.

11.2. Display

Activate colourisation of recordings within a temporal context if the table is sorted by re-
cording time. Choose if the recordings table formats recordings based on marked/checked 
state as well as split recordings. Also activate or deactivate the display of species probabil-
ities shown in the table. Furthermore you can choose sonogram preview parameters here 
as well.
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For selections containing more than 300 calls you can opt-in to either hide or show the 
calls. If you are showing such amount of calls the display will get slowed down.

11.3. Call finder

The call finder preferences influence how the call finder works. You can set the general 
call finder threshold and if this value or the value per session will be used when analysing 
calls. Another feature for recordings with a lot of echoes or from long-term monitoring in 
the open space is the adaptive call interval. You set a factor and based on the call dura-
tion multiplied with that factor a part of the recording after the call is excluded from the call 
finder. That way echoes are not misinterpreted as calls so easily and in general species 
results should be improved. Good factors are 3.0 to 7.0.

If you want to gain speed, you may change the parallelisation options. We recommend to 
keep the lowest values, if problems occur. That should already be fast enough. If you have 
an unstable or very slow call finder, you may want to switch to serial call finding mode that 
also blocks all other parts of bcAdmin to avoid interruptions. By checking run parallel call 
finder in background the call finder does not block the interface at all but runs invisibly in 
the background. This is only recommended for pro users.

Furthermore this dialog lets you choose to use the CoreML classifier instead of batIdent. 
We do recommend to use the new CoreML-based species identification. If you are using it, 
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you can still opt-in to create the csv files that were used by batIdent. These nevertheless 
are not necessary anymore

11.4. CoreML

In this dialog you can choose specific thresholds for accepting a call (left column) as well 
as the final result as correct. That means if you choose a threshold of 0.9 (=90%) a call 
needs to be at least with a probability of 90% assigned to that species. And if you choose 
0.9 (=90%) for the final result in the second column, all calls together need to achieve at 
least this overall probability.
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11.5. Expert

Here you have the possibility to adjust settings that may highly influence the call finder 
process, these should be only set by expert users. 

The experimental features allow filtering of sound data before display or analysis. Choose 
hi and or lowpass filtering to eliminate unwanted noise before analysis and display. This 
takes some calculation time but is still quite fast. You can also choose to cache sonagram 
images which is useful when accessing files over a network connections. These tend to 
have rather a lot of latency.

A new feature is influence of the call finder. The feature to eliminate calls based on a stat-
istical evaluation of call calls of a file shows very promising to get rid of noise like echoes. 
This will highly improve the CoreML species identification without sacrificing valuable data.
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11.6. Export

Parameters for export are used application wide and can be set here. That primarily influ-
ences the creation of CSV files, thus you can set column and decimal separators and 
such. If you want activity and species reports not to be transformed when exported to CSV, 
you can choose this here as well. Also, if presets for CSV export are stored, you can 
choose one here which will be used for copy and paste to other applications.

11.7. Key bindings

The file browser as well as the recording table allow the quick adding of species to the se-
lected recording. They key bindings for this feature can be set here application wide. This 
allows you to set the species entry of a recording to the one you bound to the according 
key. If you use this feature, but want to add a species, just press the alt key when using 
the quick key.

11.8. Templates

Choose the default labels for the various flags. These are used then when a new docu-
ment is created. If you created your own colour sets for species you may want to automat-
ically use it for newly created documents. To do this, just choose a PLIUST file created 
with the Taxon-Editor.
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12. Miscellaneous
12.1.Licensing

The application runs for ca. 30 days without the need of a license key. If you want to use it 
after that period you will need to buy a license. The license will be registered for your 
name and email address. Both will be regularly checked by bcAdmin via connecting to our 
license server. Thus you need to connect your Mac to the internet at least once a week (a 
mechanism exists to prolong this period if you are doing field work for example).

Multiple licenses or multiple computers
We added due to many requests a new feature in bcAdmin 3.0: you now can deactivate 
the license for one computer and activate on another, thus you can switch between mul-
tiple Macs. Running bcAdmin is possible only on one simultaneously. If you need to run it 
on multiple Macs add your wish, you can also buy additional licenses. The new license 
server can be set to allow multiple connections.
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12.2.Updates

There will be free updates to bcAdmin on a irregular basis. Note that you need a license 
including the updates for the current year.
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13. Tips & Tricks

13.1.TimeMachine Backups

Mac OS X comes with a powerful backup tool, directly implemented in the core OS: Time 
Machine. It backups you hard disc hourly and allows to travel to various points back in time 
if you need to restore a certain version of a document. All you need is an external disk and 
allow Mac OS to use it as TimeMachine volume.

13.2.Folder structure for recordings

We can recommend the following structure of folders for recordings to simplify backup and 
for moving old projects to archive disks without much hassle for bcAdmin. 

Recordings

ProjectA

SESSIONA

ProjectB

SESSIONX

100505

100515

ProjectC

SESSIONA

100601

1007005

SESSIONB

100520

100521

SESSIONC

If you use the SDHC-import feature of bcAdmin, the folders for each night (for example 
100505 = May 5th 2010) are created automatically.

This folder structure allows copying of whole projects to an external disk and allow a 
simple filelocation change for all sessions belonging to this project.
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13.3.Working with large numbers of recordings

Since the introduction of the batcorder-system its usage has changed. While in the begin-
ning single nights were recorded, today the log-term monitoring extensions are used heav-
ily. Thus, large numbers of recordings collected over a long time period have to be 
handled. This has implications on the way species identification can be audited. It is hardly 
possible to look through each recording and another scheme for auditing has to be used. 
The following process can be seen as a prototype for auditing these quantities of data and 
can be adapted to your needs. Always keep in mind, that if you work with larger numbers 
to not look at absolute sequence counts of species. If you record 10000 N. leisleri and bat-
Ident has an error rate of 10% for misclassification of N. leisleri  to V. murinus, you will end 
with around 1000 recordings classified as V. murinus. If you recorded 10, it will be 1. Thus, 
keep the percentages in your mind!

First rough auditing
In a first step, directly after importing batident results we recommend to filter Pipistrelloid 
social calls and look at these. Bad quality N. noctula calls tend to get classified as Pip-
istrelloid social calls and this can be quickly evaluated and changed via the batch replace 
species command for example. Next look at the species tree and get an overview of identi-
fied species. Then automatically replace species not occurring in your area.

Analyse species groups
After the first cleanse of identification errors certain species groups, relevant for your pro-
ject should be investigated. We recommend to browse through single nights using the file 
brwoser and activate the temporal context colourisation in the recording table. That way 
you‘ll be bale to quickly fix results for groups of recordings belonging to the same bat. 
Make heavy use of the quick keys for setting correct species results. Don‘t look at every 
single recording than but rely on the fact that a single bat will produce a couple of record-
ings if it is hunting in the vicinity. After some training you should be able to do that task 
fairly quickly without many errors. Always allow some checking by randomly selecting. 
Even after this second step some misinterpreted results will be left. They may be ignored.
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